Legal Notices

Extreme Networks, Inc., on behalf of or through its wholly-owned subsidiary, Enterasys Networks, Inc., reserves the right to make changes in specifications and other information contained in this document and its website without prior notice. The reader should in all cases consult representatives of Extreme Networks to determine whether any such changes have been made.

The hardware, firmware, software or any specifications described or referred to in this document are subject to change without notice.

Trademarks

Extreme Networks and the Extreme Networks logo are trademarks or registered trademarks of Extreme Networks, Inc. in the United States and/or other countries.

All other names (including any product names) mentioned in this document are the property of their respective owners and may be trademarks or registered trademarks of their respective companies/owners.

For additional information on Extreme Networks trademarks, please see: www.extremenetworks.com/company/legal/trademarks/

Contact

If you require assistance, contact Extreme Networks using one of the following methods.

- **Global Technical Assistance Center (GTAC) for Immediate Support**
  - **Phone:** 1-800-998-2408 (toll-free in U.S. and Canada) or 1-603-952-5000. For the Extreme Networks support phone number in your country, visit: www.extremenetworks.com/support/contact
  - **Email:** support@extremenetworks.com. To expedite your message, enter the product name or model number in the subject line.
- **GTAC Knowledge** — Get on-demand and tested resolutions from the GTAC Knowledgebase, or create a help case if you need more guidance.

- **The Hub** — A forum for Extreme customers to connect with one another, get questions answered, share ideas and feedback, and get problems solved. This community is monitored by Extreme Networks employees, but is not intended to replace specific guidance from GTAC.

- **Support Portal** — Manage cases, downloads, service contracts, product licensing, and training and certifications.
# Table of Contents

Table of Contents ........................................................................................................... 4

About This Guide .............................................................................................................. 6

Engine Overview and Setup ............................................................................................ 7

  Kit Contents ...................................................................................................................... 7

  Specifications .................................................................................................................... 7

  Front Panel Features ....................................................................................................... 9

    Hard Drive LED Indicator Patterns ............................................................................. 10

  Back Panel Features ....................................................................................................... 10

    Power Supply Status Indicator Patterns ..................................................................... 11

Removing and Installing the Front Bezel ........................................................................ 12

  Removing the Front Bezel .............................................................................................. 12

  Installing the Front Bezel .............................................................................................. 12

  Installing the Engine into a Rack ................................................................................... 13

  Torque Values .................................................................................................................. 14

Configuration .................................................................................................................... 15

  Pre-Configuration Tasks ............................................................................................... 15

  Configuring the Engine ................................................................................................. 15

  Launching Extreme Management Center Applications .............................................. 23

Restoring a Database from a Windows Server to the Engine ........................................ 24

  Changing Console ......................................................................................................... 24

  Changing Syslog Location ............................................................................................ 24

  Changing Traps Location .............................................................................................. 24

  Changing Inventory Manager ....................................................................................... 25
Changing Engine Settings ............................................................... 25
Changing Basic Network Configuration ........................................... 25
Changing SNMP Configuration ..................................................... 25
Changing Date and Time Settings .................................................. 26
Upgrading Extreme Management Center Engine Software ............... 26
Reinstalling Engine Software .......................................................... 28

Product Regulatory and Compliance Information ............................ 30
Federal Communications Commission (FCC) Notice ......................... 30
Industry Canada, Class A ............................................................... 31
CE Notice ...................................................................................... 31
VCCI Notice .................................................................................. 31
BSMI EMC Statement — Taiwan .................................................. 31
Hazardous Substances ................................................................... 32
European Waste Electrical and Electronic Equipment (WEEE) Notice .... 32
Declaration of Conformity ............................................................... 34
About This Guide

This document describes the installation and initial configuration of the Extreme Management Center NMS-A-25 hardware engine.

This document is intended for experienced network administrators who are responsible for implementing and maintaining communications networks.
Engine Overview and Setup

This chapter lists the components shipped with the NMS-A-25 engine, describes the front and back panels, and provides information on engine specifications.

For complete regulatory compliance and safety information, refer to the document *Intel® Server Products Product Safety and Regulatory Compliance*, available at the following links:

[http://download.intel.com/support/motherboards/server/sb/g23122003_safetyregulatory.pdf](http://download.intel.com/support/motherboards/server/sb/g23122003_safetyregulatory.pdf)

Kit Contents

The NMS-A-25 engine ships with the following components:

- Extreme Networks URL card
- Front bezel label
- A rack mounting kit
- Two rack handles and appropriate screws
- AC power cord bracket and cable clamp kit
- One USB flash drive

Specifications

The physical specifications for the engine are listed in the following tables.

<table>
<thead>
<tr>
<th>NMS-A-25 Physical Specifications</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor type</td>
<td>NMS-A-25 - Intel® Xeon® E5-2620 v4 processor</td>
</tr>
<tr>
<td>Processor speed</td>
<td>2.1GHz</td>
</tr>
<tr>
<td>CPU Cores</td>
<td>8</td>
</tr>
<tr>
<td>Memory</td>
<td>2400MHz Dual Ranked Registered (RDIMM) ECC DDR4</td>
</tr>
</tbody>
</table>
Memory module capacities | 4 GB DIMMs
---|---
Minimum RAM (included) | 32 GB (eight 4 GB DIMMs)
Maximum RAM | 48 GB (twenty-four 2 GB RDIMMs)

**Drives**

| Hard drives | One 480 GB SSD hard drive |

**Connectors**

**Back**

| NIC | Four RJ-45 |
| Serial | 9-pin, DTE, 16550-compatible |
| USB | Three 4-pin, USB 2.0-compliant |
| Video | 15-pin VGA |
| Networking | Two 1 GB Ethernet |

**Front**

| USB | Two 4-pin, USB 2.0-compliant |
| Video | 15-pin VGA |

**Power**

| AC power supply (per power supply) | Redundant power supply |
| Wattage | 750 watts |
| Input voltage | • 90 - 132 V at 47/63 Hz 8.2 A  
               • 180 - 264 V at 47/63 Hz 4.4 A |
| Output voltage | • 620A at 12 V  
                 • 2.1A at 12 VSB |

**Physical**

| Height | 4.45 cm (1.72 in.) |
| Width | 43.0 cm (16.93 in.) |
| Depth | 70.99 cm (27.95 in.) |
| Weight (maximum configuration) | 13.15 kg (29 lb.) |

**NMS-A-25 Environmental Specifications**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>+10°C (+50°F) to +35°C (+95°F) with the maximum rate of change not to exceed 10°C (+50°F) per hour</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-40°C (-40°F) to +70°C (+158°F)</td>
</tr>
<tr>
<td>Storage humidity</td>
<td>50% to 90%, non-condensing at 28°C (82°F)</td>
</tr>
</tbody>
</table>
## Front Panel Features

This section shows the front panel and describes the major features.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vibration, unpackaged</td>
<td>5 Hz to 500 Hz, 2.20 g RMS random</td>
</tr>
<tr>
<td>Shock, operating</td>
<td>Half sine, 2 g-force peak, 11 milliseconds</td>
</tr>
<tr>
<td>Shock, unpackaged</td>
<td>Trapezoidal, 25 g, velocity change 136 inches/second (40 lb to &lt; 80 lb)</td>
</tr>
<tr>
<td>Shock, packaged</td>
<td>Non-palletized free fall in height 24 inches (40 lb to &lt; 80 lb)</td>
</tr>
<tr>
<td>ESD</td>
<td>±12 KV except I/O port ±8 KV per Intel® Environmental test specification</td>
</tr>
<tr>
<td>Estimated thermal dissipation</td>
<td>1550 BTU/Hr</td>
</tr>
</tbody>
</table>

### NMS-A-25 Front Panel Features

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>System label pull-out</td>
</tr>
<tr>
<td>B</td>
<td>Video Connector</td>
</tr>
<tr>
<td>C</td>
<td>USB 3.0 Ports</td>
</tr>
<tr>
<td>D</td>
<td>Front control panel (see figure below)</td>
</tr>
<tr>
<td>E</td>
<td>Hard disk drive bays</td>
</tr>
</tbody>
</table>
Back Panel Features

Front Control Panel

| A | System ID button w/integrated LED | F | System status LED |
| B | NMI button (recessed, tool required for use) | G | Power button w/integrated LED |
| C | Mgmt port activity LED | H | Hard drive activity LED |
| D | Not used | I | Not used |
| E | System cold reset button | J | Not used |

**Hard Drive LED Indicator Patterns**

The hard drive has two LED indicators visible from the front of the system: one is a green LED for disk activity, and the other is amber and indicates hard drive status. The following tables describe the LED states.

**Hard Drive Activity LED Indicator Patterns**

<table>
<thead>
<tr>
<th>Activity LED Patterns</th>
<th>Hard Drive Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Power on and drive spinning up or spinning down</td>
</tr>
<tr>
<td>Blinking green</td>
<td>Power on with drive activity</td>
</tr>
</tbody>
</table>

**Hard Drive Status LED Indicator Patterns**

<table>
<thead>
<tr>
<th>Status LED Patterns</th>
<th>Hard Drive Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No access or no fault</td>
</tr>
<tr>
<td>Solid amber</td>
<td>Hard drive fault has occurred</td>
</tr>
</tbody>
</table>

**Back Panel Features**

This section shows the back panel and describes the major features.
The following table describes the LEDs for the RJ45 management port.

### RJ45 Port LEDs (Management Port)

<table>
<thead>
<tr>
<th>LED Type</th>
<th>LED Pattern</th>
<th>Status Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network speed (right)</td>
<td>Off</td>
<td>10 Mbps</td>
</tr>
<tr>
<td></td>
<td>Amber</td>
<td>100 Mbps</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>1000 Mbps</td>
</tr>
<tr>
<td>Link activity (left)</td>
<td>Off</td>
<td>No link</td>
</tr>
<tr>
<td></td>
<td>Solid Green</td>
<td>Active link</td>
</tr>
<tr>
<td></td>
<td>Blinking Green</td>
<td>Data traffic activity</td>
</tr>
</tbody>
</table>

### Power Supply Status Indicator Patterns

The engine has two power supplies, supplying hot-pluggable power redundancy. The system distributes the power load across both power supplies to maximize efficiency.

Each power supply has a single bi-color LED to indicate power supply status, as described in the table below.
Removing and Installing the Front Bezel

The NMS-A-25 engine comes with an optional front panel bezel that can be attached to the front of the chassis by snapping the bezel onto the chassis handles. A key lock allows you to lock the bezel in place so that front panel controls cannot be used. You can still monitor system status indicators with the bezel in place.

Removing the Front Bezel

To remove the front bezel:

1. Unlock the bezel if it is locked.
2. Remove the left end of the front bezel from rack handle.
3. Rotate the front bezel counterclockwise to release the latches on the right end from the rack handle.

Installing the Front Bezel

Note: Before installing the bezel, you must install the rack handles. See Installing the Engine into a Rack.

To install the front bezel:

### Power Supply Status LED Indicator Patterns

<table>
<thead>
<tr>
<th>LED Pattern</th>
<th>Power Supply Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Output on and OK</td>
</tr>
<tr>
<td>Off</td>
<td>No AC power to all power supplies</td>
</tr>
<tr>
<td>1 Hz blinking green</td>
<td>AC present / Only 12VSB on (PS off) or PS in cold redundant state</td>
</tr>
<tr>
<td>Amber</td>
<td>AC power cord unplugged or AC power lost. With a 2nd PS in parallel still with AC input power</td>
</tr>
<tr>
<td>1 Hz blinking amber</td>
<td>Power supply warning events where PS continues to operate — high temp, high power, high current, slow fan</td>
</tr>
<tr>
<td>Amber</td>
<td>Power supply critical event causing a shutdown, failure, OCP, OVP, fan fail</td>
</tr>
<tr>
<td>2 Hz blinking green</td>
<td>Power supply firmware updating</td>
</tr>
</tbody>
</table>
1. Lock the right end of the front bezel to the rack handle.
2. Rotate the front bezel clockwise till the left end clicks into place.
3. Lock the bezel, if needed.

**Installing the Engine into a Rack**

A rack mounting kit and installation guide are included with the NMS-A-25 engine. The rack mounting kit allows you to install the engine into a four-post rack cabinet. Refer to the installation guide for complete installation instructions.

If you are table mounting the engine, ensure at least 6 cm (2.4 in) of clearance on all sides of the engine for proper ventilation.

If you are installing the engine in a rack:

1. Install the rack handles by aligning a rack handle with the two holes on each side of the engine and attaching each handle to the engine with two screws as shown in the figure below.

![Installing the Rack Handles](image)

2. Read the installation guide included with the rack mounting kit.
3. Install the rails and mount the controller in the rack as instructed.
Torque Values

The following table describes the recommended torque values to use when installing the engine using standard threaded fastener machine screws and bolts.

<table>
<thead>
<tr>
<th>Screw Size</th>
<th>Torque in Pounds</th>
<th>Bit Size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Nominal</td>
<td>+%5</td>
</tr>
<tr>
<td>N/A</td>
<td>1.42</td>
<td>1.5</td>
</tr>
<tr>
<td>2 – 56</td>
<td>1.5</td>
<td>2.85</td>
</tr>
<tr>
<td>4 – 40</td>
<td>2.5</td>
<td>4.75</td>
</tr>
<tr>
<td>6 – 32</td>
<td>3.5</td>
<td>8.55</td>
</tr>
<tr>
<td>8 – 32</td>
<td>4.5</td>
<td>17.10</td>
</tr>
<tr>
<td>10 - 32</td>
<td>5</td>
<td>30.40</td>
</tr>
<tr>
<td>1/4 – 20</td>
<td>6.5</td>
<td>63.65</td>
</tr>
</tbody>
</table>
Configuration

Once you have installed the engine into a rack, you need to connect a monitor and a USB keyboard, connect the power cord and network cable, and power it on.

After the engine boots and the engine installation is complete, you must go through the initial configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following your initial configuration and how to upgrade the Extreme Management Center application software. For information on reinstalling the Extreme Management Center engine software, see Reinstalling Engine Software.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing the configuration steps in the next section:

- Engine hostname, IP address, and netmask
- Default gateway IP address
- Name server IP address and domain name
- NIS (Network Information Services) server IP address
- Network Time Protocol (NTP) server IP address

In addition, you need to obtain the appropriate Extreme Management Center software license prior to launching the Extreme Management Center applications. You are prompted to enter a license when you launch the application. (When you purchased Extreme Management Center, you received a Licensed Product Entitlement ID. This Entitlement ID allows you to generate a product license. Refer to the instructions included with the Entitlement ID that was sent to you.)

Configuring the Engine

After the initial engine installation is complete, use the following steps to configure the engine to run the Extreme Management Center engine software:
1. Login as root with no password, and press Enter. The following screen appears:

```
login: root
Password: 
Welcome to the Extreme Management Center Engine Setup
```

Please enter the information as it is requested to continue with the configuration. Typically a default value is displayed in brackets. Pressing the [enter] key without entering a new value will use the bracketed value and proceed to the next item. If a default value cannot be provided, the prompt will indicate that the item is either (Required) or (Optional). The [enter] key may be pressed without entering data for (Optional) items. A value must be entered for (Required) items. At the end of the setup process, the existing settings will be displayed and opportunity will be provided to correct any errors.

```
Press [enter] to begin setup or CTRL-C to exit:
```

2. Press [Enter] to begin the setup. The Root Password Configuration screen appears:

```
login: root
Password: 
Welcome to the Extreme Management Center Engine Setup
```

Please enter the information as it is requested to continue with the configuration. Typically a default value is displayed in brackets. Pressing the [enter] key without entering a new value will use the bracketed value and proceed to the next item. If a default value cannot be provided, the prompt will indicate that the item is either (Required) or (Optional). The [enter] key may be pressed without entering data for (Optional) items. A value must be entered for (Required) items. At the end of the setup process, the existing settings will be displayed and opportunity will be provided to correct any errors.

```
Would you like to set a root password (y/n) [y]?
```
Note: You must set a new root password. This new root password is used by the initial user when logging in to the Extreme Management Center applications.

3. Press Enter to set a new root password. Enter the new password as prompted.

Enter new UNIX password:
Retype new UNIX password:
Password updated successfully.

4. After you create the new root password, a screen appears where you can specify a user other than root to run the Extreme Management Center server, if desired. This user becomes the admin user for the server.

Select the user to run the server as
Do you want to use an existing user? (y/n) [y]

5. Enter y to use an existing user if you already have a user defined on the machine and enter the user name. Leave the name set to root if you do not want to specify another user. Accept your selection. Enter n to create a new “netsight” user (netsight is the user name) and enter the password for this new user. Re-enter the password and then accept your selection.

6. In the Extreme Management Center Suite Engine Network Configuration screen, enter the requested configuration information and press Enter.

If you plan to use DNS, enter the IP address of the name server. If you are using a name server, enter a domain name for the engine. If you are using an NIS server to authenticate users logging into the engine, make sure the NIS domain name is valid or users may not be able to log in to the Extreme Management Center applications.
Configuring the Engine

Enter the hostname for the engine (Required):
Enter the IP address for <hostname> [192.168.1.10]:
Enter the IP netmask [255.255.255.0]:
Enter the gateway address [192.168.1.1]:
Enter the IP address of the name server (Optional):
Enter the domain name for <hostname> (Optional):

Do you want to use NIS (y/n) [n]? y
Enter the IP address of the NIS server:
Enter the NIS domain name (Required):

7. In the Confirm Network Settings screen, you can accept the current configuration or modify the settings.

---

Confirm Network Settings
---

These are the settings you have entered. Enter 0 or any key other than a valid selection to continue. If you need to make a change, enter the appropriate number now or run the /usr/postinstall/dnetconfig script at a later time.
---

0. Accept settings and continue
1. Hostname: <hostname>
2. IP address: 192.168.1.10
3. Netmask: 255.255.255.0
4. Gateway: 192.168.1.1
5. Nameserver:
6. Domain name: <domain name>
7. NIS Server/Domain:
Enter selection [0]:

8. In the SNMP Configuration screen, enter the requested information for each line and press Enter.
Configuring the Engine

SNMP Configuration

The following information will be used to configure SNMP management of this device. The SNMP information entered here must be used to contact this device with remote management applications such as Extreme Management Center Console.

Please enter the SNMP user name [snmpuser]:
Please enter the SNMP authentication credential [snmpauthcred]:
Please enter the SNMP privacy credential [snmpprivcred]:

9. In the Configure Date and Time Settings screen, select whether you want to use an external Network Time Protocol (NTP) server. Enter y to use NTP, and enter your NTP server IP address(es). Enter n to configure the date and time manually and proceed to step 11.

Do you want to use NTP (y/n) [y]? y
Please enter a NTP Server IP Address (Required): 144.131.10.120
Would you like to add another server (y/n) [n]? y
Please enter a NTP Server IP Address (Required): 144.131.10.121
Would you like to add another server (y/n) [n]? n
10. In the NTP Servers validate selection screen, enter 0 to accept the current settings and proceed to the Set Time Zone screen in step 13.

```
NTP Servers

These are the currently specified NTP servers. Enter 0 or any key other than a valid selection to complete NTP configuration and continue.
If you need to make a change, enter the appropriate number from the choices listed below.
144.131.10.120
144.131.10.121
0. Accept the current settings
1. Restart NTP server selection
2. Set date and time manually
```

Enter selection [0]: 0

If you answered no to using an NTP server to set date and time, set the date and time in the Set Date and Time screen.

```
Set Date And Time

The current system date and time is: Thu Oct 28 09:34:08 2013
Please enter the values for date and time as directed where input is expected in the following format:
MM - 2 digit month of year
DD - 2 digit day of month
YYYY - 4 digit year
hh - 2 digit hour of day using a 24 hour clock
mm - 2 digit minute of hour
```
ss - 2 digit seconds

Please enter the month [10]:
Please enter the day of the month [28]:
Please enter the year [2013]:
Please enter the hour of day [09]:
Please enter the minutes [34]:
Please enter the seconds [08]:

1. In the Use UTC screen, select whether you want the system clock to be set to use UTC.

---

Use UTC
---

The system clock can be set to use UTC. Specifying no for using UTC, sets the hardware clock using localtime.

---

Do you want to use UTC (y/n) [n]?

2. In the Set Time Zone screen, select the appropriate time zone and press Enter.

---

Set Time Zone
---

You will now be asked to enter the time zone information for this system. Available time zones are stored in files in the /usr/share/zoneinfo directory. Please select from one of the following example time zones:
1. US Eastern
2. US Central
3. US Mountain
4. US Pacific
3. The Modify Settings screen summarizes the settings you have entered and provides an opportunity to modify the settings, if desired. Enter 0 to accept the settings.

The Extreme Management Center engine software is automatically installed. This could take a few minutes. When the installation is complete, you’ll see the following screen:
Setup of the Extreme Management Center Engine is now complete. The engine is now operational and ready to accept remote connections. Details of the installation are located in the /var/log/install directory.

---

Launching Extreme Management Center Applications

Now that you have configured the Extreme Management Center engine, you are ready to access the Extreme Management Center Launch Page and run the applications from a remote client machine.

1. Open a browser window on the remote client machine and enter the Extreme Management Center Launch page URL in the following format:
   http://<servername>:8080/
   where <servername> is the Extreme Management Center engine IP address or hostname, and 8080 is the required port number. For example, http://10.20.30.40:8080/
   The Extreme Management Center Launch Page opens.

2. Launch your Extreme Management Center applications by clicking on the names or icons of any of the listed applications.
   A login window appears.

3. Log in as root with the same password you defined in or as the user you specified in Step 3.
   This is because the Extreme Management Center Server has a single predefined user that is the user who performed the installation. Once the initial user has logged in, additional users can be defined.

The first time you attempt to launch an Extreme Management Center application, you are prompted for the license text you received when you generated your Extreme Management Center product license.

For more information on the Extreme Management Center Launch page, access the Online Help by clicking on ? in top-right corner. In the Online Help Table of Contents, select Installation Guide and then read the section titled "Remote Client Launch."

23 of 34
Restoring a Database from a Windows Server to the Engine

This section describes several Extreme Management Center configuration changes that are required if you are moving your Extreme Management Center installation from a Windows platform system to the engine. The steps are performed after restoring your database to the new engine. (For information on restoring a database, see the Server Information section in the Extreme Management Center Suite-Wide Tools User Guide.)

Changing Console

Use the following instructions to change the location of syslog and trap information to the new location on the engine.

Changing Syslog Location

Change the Syslog Log Manager to point to the new location on the engine. This allows the display of syslog information in the Syslog Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.
2. Click on the Syslog entry under Available Log Managers, and click the Edit button. The Log Manager Parameters window opens.
3. Change the path in the Log Directory field to /var/log/messages.
4. Change the Pattern to Red Hat LINUX Syslog Pattern.
5. Click OK.

Changing Traps Location

Change the Traps Log Manager to point to the new location on the engine. This allows the display of trap information in the Traps Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.
2. Click on the Traps entry under Available Log Managers, and click the Edit button. The Log Manager Parameters window opens.
3. Change the path in the Log Directory field to $logdir%/traps.
4. Click OK.
Changing Inventory Manager

If you are using Inventory Manager, you must change the Data Storage Directory path to point to the new location on the engine. The Data Storage Directory is where all Inventory Manager data is stored, including capacity planning reports, configuration templates, archived configurations, and property files.

1. Open Management Center and select Administration > Options > Inventory Manager.
2. Select Directory Path in the Data Storage section of the tab.
3. Change the path to the correct new location.
   On a default Linux install, the path is:
   /usr/local/Extreme_Networks/NetSight/appdata/InventoryMgr/
4. Click OK.

Changing Engine Settings

Use these steps if you need to change your Extreme Management Center engine settings following your initial engine configuration.

Changing Basic Network Configuration

To change basic network configuration settings such as hostname and engine IP address, enter the following command at the engine CLI:

/usr/postinstall/dnetconfig

This starts the network configuration script and allows you to make the required changes. Reboot the engine for the new settings to take effect.

Changing SNMP Configuration

To change SNMP configuration settings such as system contact, system location, Trap Server, SNMP Trap Community String, SNMP User, SNMP Authentication, and SNMP Privacy credentials, enter the following command at the engine CLI:

/usr/postinstall/snmpconfig
This starts the SNMP configuration script and allows you to make the required changes.

**Changing Date and Time Settings**

To enable or disable NTP for engine date and time, or to manually set the date and time on the engine, enter the following command at the engine CLI:

```
/usr/postinstall/dateconfig
```

This starts the date and time configuration script and allows you to change the settings.

**Upgrading Extreme Management Center Engine Software**

Upgrades to the Extreme Management Center engine software are available on the Extreme Portal.

1. Download the Engine Image 64-bit upgrade file to your system.

   To download an engine image:
   
   2. After entering your email address and password, you are on the Support page.
   3. Click the Products tab and select ExtremeManagement.
   4. Click ExtremeManagement in the right-panel.
   5. Select a version.
   6. Download the image and extract the file to a directory on your system.

2. Use FTP, SCP, or a shared mount point, to copy the upgrade file to the Extreme Management Center engine.

3. SSH to the engine.

4. Cd to the directory where you downloaded the upgrade file.

5. Change the permissions on the upgrade file by entering the following command:

   ```
   chmod 755 NetSight_Suite_<version>_install.bin
   ```

6. Run the install program by entering the following command:

   ```
   ./NetSight_Suite_<version>_install.bin
   ```
The upgrade automatically begins.

The Extreme Management Center Server is restarted automatically when the upgrade is complete. Because your Extreme Management Center engine settings were migrated, you are not required to perform any configuration on the engine following the upgrade.
Reinstalling Engine Software

Use the procedure in this chapter to reinstall the engine software, in the event a software reinstall becomes necessary. Be aware this procedure reformats the hard drive and reinstalls all the engine software, the operating system, and all related Linux packages.

Connect a monitor and a USB keyboard to the engine prior to performing these steps.

1. Download the Engine Image 64-bit upgrade file to your system.

To download an engine image:

2. After entering your email address and password, you are on the Support page.
3. Click the Products tab and select ExtremeManagement.
4. Click ExtremeManagement in the right-panel.
5. Select a version.
6. Download the image and extract the file to a directory on your system.

2. Insert the USB flash drive that came with the engine into the USB port on your system and note the drive letter it is assigned.

3. Open a command prompt window and cd to the directory where you extracted the file.

4. Type make_disk.bat <drive letter>:.

   **Note:** Because the reinstall procedure reformats the drive, be sure you have specified the correct drive letter.

5. Press [Enter].

   The files are copied to the USB flash drive. When the copy is complete you see the message:

   Successfully installed into <drive letter>: Press any key to continue.

6. Remove the USB flash drive from your system.

7. Insert the USB flash drive into a USB port on the engine (see Front Panel Features).

8. Boot the engine from the USB drive using either of these two methods.

   **Method 1:**
1. Press the power button, and then press F6 to go to the Boot Menu.
2. Select the USB drive on the menu.
3. The engine starts booting from the USB flash drive.
4. When the boot is complete, the Engine Installation screen appears and the installation begins.

**Method 2:**
1. Press the power button, and then press F2 to go to the BIOS setup.
2. Use the arrow keys to navigate to the Boot Options menu.
3. Ensure that the USB flash drive is listed as Boot Option #1 at the top.
4. Save changes and exit.
5. The engine starts booting from the USB flash drive.
6. When the boot is complete, the Engine Installation screen appears and the installation begins.

9. After the installation completes, reboot the engine and remove the USB flash drive.
10. Proceed to [Configuration](#), and follow the instructions for configuring the engine.
Product Regulatory and Compliance Information

For complete regulatory compliance and safety information, refer to the document Intel® Server Products Product Safety and Regulatory Compliance, available at the following links:

http://download.intel.com/support/motherboards/server/sb/g23122003_safetyregulatory.pdf
https://www.extremenetworks.com/support/documentation/

Federal Communications Commission (FCC) Notice

This product has been tested and found to comply with the limits for a class A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This product uses, generates, and can radiate radio frequency energy and if not installed and used in accordance with the manufacturer’s instruction manual, may cause harmful interference to radio communications. Operation of this product in a residential area is likely to cause harmful interference, in which case you will be required to correct the interference at your own expense.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Any changes or modifications not expressly approved by the grantee of this device could void the user’s authority to operate the equipment. The customer is responsible for ensuring compliance of the modified product.

Intel Corporation
5200 N.E. Elam Young Parkway
Hillsboro, OR 97124 6497
Phone: 1 800 628 8686
Industry Canada, Class A

This Class A digital apparatus complies with Canadian ICES-003.

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the interference-causing equipment standard entitled “Digital Apparatus,” ICES-003 of the Canadian Department of Communications.

Cet appareil numérique respecte les limites bruits radioélectriques applicables aux appareils numériques de Classe A prescrites dans la norme sur le matériel brouilleur: “Appareils Numériques”, NMB-003 édictée par le Ministre Canadian des Communications.

CE Notice

This product has been determined to be in compliance with 2006/95/EC (Low Voltage Directive), 2004/108/EC (EMC Directive).

VCCI Notice

This is a class A product based on the standard of the Voluntary Control Council for Interference by Information Technology Equipment (VCCI). If this equipment is used in a domestic environment, radio disturbance may arise. When such trouble occurs, the user may be required to take corrective actions.

BSMI EMC Statement — Taiwan

This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate
Hazardous Substances

This product complies with the requirements of Directive 2011/65/EU of the European Parliament and of the Council of 8 June 2011 on the restriction of the use of certain hazardous substances in electrical and electronic equipment.

European Waste Electrical and Electronic Equipment (WEEE) Notice

In accordance with Directive 2012/19/EU of the European Parliament on waste electrical and electronic equipment (WEEE):

1. The symbol above indicates that separate collection of electrical and electronic equipment is required.

2. When this product has reached the end of its serviceable life, it cannot be disposed of as unsorted municipal waste. It must be collected and treated separately.

3. It has been determined by the European Parliament that there are potential negative effects on the environment and human health as a result of the presence of hazardous substances in electrical and electronic equipment.

4. It is the users’ responsibility to utilize the available collection system to ensure WEEE is properly treated.
For information about the available collection system, please contact Extreme Customer Support at +353 61 705500 (Ireland).

## Supplement to Product Instructions

<table>
<thead>
<tr>
<th>部件名称（Parts）</th>
<th>有毒有害物质或元素（Hazardous Substance）</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>铅（Pb）</td>
</tr>
<tr>
<td>金属部件（Metal Parts）</td>
<td>×</td>
</tr>
<tr>
<td>电路模块（Circuit Modules）</td>
<td>×</td>
</tr>
<tr>
<td>电缆及电缆组件（Cables &amp; Cable Assemblies）</td>
<td>×</td>
</tr>
<tr>
<td>塑料和聚物部件（Plastic and Polymeric parts）</td>
<td>ø</td>
</tr>
<tr>
<td>电路开关（Circuit Breakers）</td>
<td>ø</td>
</tr>
</tbody>
</table>

◇：表示该有毒有害物质在该部件所有均质条件下的含量均在 SJ/T 11363-2006 标准规定的限量要求以下。Indicates that the concentration of the hazardous substance in all homogeneous materials in the parts is below the relevant threshold of the SJ/T 11363-2006 standard.

×：表示该有毒有害物质至少在该部件的某一均质条件下的含量超出 SJ/T 11363-2006 标准规定的限量要求。Indicates that the concentration of the hazardous substance of at least one of all homogeneous materials in the parts is above the relevant threshold of the SJ/T 11363-2006 standard.

对销售之日的销售产品，本表显示，即将供应的电子信息产品可能存在这些物质。注意：在销售产品中可能会也可能不会含有所有所列的部件。This table shows where these substances may be found in the supply chain of Extreme’s electronic information products, as of the date of sale of the enclosed product. Note that some of the component types listed above may or may not be a part of the enclosed product.
Declaration of Conformity

                                            2006/95/EC
                                            2011/65/EU

Manufacturer's Name: Extreme Networks, Inc.
Manufacturer's Address: 145 Rio Robles
                                      San Jose, CA 95134
                                      USA

European Representative Name: Extreme Networks Limited
European Representative Address: Nexus House, Newbury Business Park
                                      London Road, Newbury
                                      Berkshire RG14 2PZ, England

Conformance to Directive (s)/Product Standards:
                                                61000-3-2:2006 A1:2009 A2:2009 EN 61000-
                                                3-3:2008 EC Directive 2006/95/EC EN
                                                2011/65/EU

Equipment Type/Environment: Information Technology Equipment, for use in a
                                      Commercial or Light Industrial Environment.

The object of the declaration described above is in conformity with Directive
2011/65/EU of the European Parliament and of the Council of 8 June 2011 on the
restriction of the use of certain hazardous substances in electrical and electronic
equipment.